1. INTRODUCTION
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[bookmark: _Hlk179618966]Security is the degree of resistance and resilience to, or protection from harm [1]. Security is threatening every part of man’s life, and infrastructure is not an exception either. Generally, Security is a state of being free from threat and danger. It is also said to be the state of safety being in the Organization or Industry against criminal activities such as Terrorism, Kidnapping, Theft, Piracy, and Espionage [2]. Security in a train compartment is a vital aspect to ensure the safety and well-being of passengers or cargo. Lack of security is a significant concern for passengers utilizing trains as a means of transportation. Theft, harassment, kidnapping, violence, and Espionage are common nowadays among commuters. The absence of adequate security personnel and poor implementation of safety measures have contributed to this problem. Over the years, there was never special security surveillance, monitoring measures, rather than lockable doors and windows, an emergency alarm system, and Regular patrols by train personnel. The need for security and safety in the industry, public or private sectors is of utmost importance. The development of various devices that serve the desired purpose has led to an increase in safety. Safety is not only about the physical possession of an organization, but also the integrated protection. Years ago, products were designed to serve a single purpose, and the majority of the devices designed were only to secure lives and properties, even in homes and industries [3]. Many security systems have been developed and deployed to ensure adequate security of facilities, both in residences and industries. Over the years, such system includes Closed-circuit TV(CCTV), internet protocol (IP) Camera system, Digital or Network Video recorder (DVR/NVR), among others were deployed to ensure adequate security of properties and lives, both in residences and industries, but many concerns have arisen regarding the effectiveness and stability of these security systems. Though many innovations had been developed and adapted to secure the safety of lives and properties. But the major adopted measure to ensure the proper security of lives and properties is the security, surveillance and monitoring system. The security, surveillance and monitoring system is a device comprising hardware and software components or modules assembled and used for monitoring behavior, activities, persons or places, because of a crime that has happened or is expected to happen [4].
This process of surveillance and monitoring includes a distance observation through electronic gadgets, such as closed-circuit television cameras and the interception of electronically transmitted information, such as Passive Infrared detectors, phone calls and radio frequency [5]. Monitoring of persons and activities within requires round-the-clock observation by the provided security agents, who in any event of physical intrusion, respond quickly with short notice and a safe distance. CCTV is often projected as a silver bullet that solves all security woes but when an individual is not physically present to monitor activities happening, the task of using CCTV is defected, human errors, fatigue and ripping away recorded data by criminals is another problem affecting the use of CCTV. The absence of adequate security personnel and poor implementation of safety measures have contributed to this problem.
To remedy these challenges and ensuring a robust protection of lives and properties, there is need to develop a comprehensive integrated based surveillance monitoring security system using the internet of things or setting up of an integrated based video surveillance system in monitoring real time invent with a much wider and effective coverage area to enable the control unit makes a well-informed decision appropriately, which will be very helpful in respect of insecurity [6] 
A smart, intelligent video camera sensor with the cloud to analyze live footage events content, captured by the camera, leading to desired action taking without human intervention. Constantly recording all the activities or happenings inside a train compartment, avoiding impending failures through the Internet of Things. The Internet of Things is a network platform that exchanges data feeds into it to enable communication and automation control. It connects physical devices with sensors, software and other technological innovations for the purpose of exchanging communication between devices and the cloud through a digital interface [7] 
The Internet of Things is the rapid advancement that has been transforming the current Internet platform from the old contemporary way of interaction into an interconnected network of devices. The attractive characteristics of IoTs are the understanding of cognitive radio, which has raised the chances of creating a smart world [8]. 
The advancement, less-cost-effective technology and protocol authorize us to make practical Internet of Things implementation which impacts on human lifestyle, business and industries. Internet of Things technology has opened up more doors of chances for the development of smart systems and applications. An IoT system is typically incorporated with sensors, software, digital machines and consumer objects. Incorporated also in this proposed study is a gas leakage detector for detecting and monitoring the air level for toxic and dangerous multiple gases. Gases like methane, propane, butane, carbon monoxide, smoke, and LPG can cause health hazards in the human system. 
This work consist of an express if 32-cam (ESP 32 CAM) sensor module embedded with camera, passive infrared (PIR) sensor module and MQ-2 sensor module incorporated in the surveillance monitoring system, the video microcontroller also known as the ESP 32-CAM embedded with camera detects, captures and record any activities visually inside the train compartment on receiving a HIGH signal from the PIR sensor and the dangerous multiple gas notification from the MQ2 sensor. This work is designed, and when implemented in a train compartment, it will serve as a gas detector and a security measure for the safety of lives, properties and facilities.
                                         [image: ]
                                         Fig. 1. Internet of Things (Rakshitha et al., 2017).

2. REVIEW OF RELATED WORK
This section presents various relevant security systems proposed by different researchers. Different research works have proposed novel architectures and deployments of smart surveillance systems using IoT solutions that comprised sensors and camera modules in order to detect motion captured live streaming footage in different fields of technology.
The development and implementation of an integrated system for surveillance, monitoring and security using the Internet of Things (IoT) have yielded significant remarks over traditional improvements and some contemporary smart designs. Before the modern digital surveillance system, the traditional methods like visual inspection, physical deterrence, human observation, physical barriers and basic alarm systems were the basic methods adopted for surveillance, monitoring and security. 
Not until the mid-20th century, when the transition to electronic surveillance was marked as a significant development, was closed-circuit television (CCTV) introduced. These innovation systems were often analogue cameras that transmitted live footage to monitors. Recording capabilities were limited, and security personnel had to physically and continuously monitor live feeds. This results in some challenges such as errors in human judgement, fatigue, ripping and carting away of recorded stored data and limitation of human vision [9]. 
In a proposed work, [10], an Internet of Things-based automated home security system utilizing a Raspberry Pi. This device was installed at the main entrance of a user’s office or home. The device sends a security alert and simultaneously registers a notification email on the user's smartphone in any location or place in the world through the internet. Similarly,[11] developed an Ontology-based Context-aware IoT Framework for Smart Surveillance: In their work, the continuous live video streaming and data captured by CCTV cameras are processed on the fly to give real-time alerts to concerned authorities, and these notification alerts are disseminated using SMS/ E-mail.
Recently proposed work by [12] developed and implemented an Internet of Things-based Smart Surveillance and Automation: They utilize a smart system based on Raspberry Pi 3B using Internet of Things architecture and several sensors with other devices for room security to set up a safer environment. The authors did a good job by introducing a complete solution to the problems, by implementing an effective object detection model utilizing Machine Learning and combining it with advanced Image Enhancement technology.

However, these researchers or authors depend and rely on SMS/Email devices to utilise Manual monitoring and notification processes. SMS or Email leads to delayed quick time responses and increased security risks. The Email is a potential for delayed responses, as the Email may not be immediately checked or responded to. Additionally, inbox clutter and distractions can cause important notifications to be missed or overlooked.  Furthermore, Email notifications are vulnerable to security risks, such as cyber threats and data breaches.
According to [13], who designed a home security system-based Internet of Things. The author built the system around Ardurno uno microcontroller, to interconnect the various components, of a magnetic Reed sensor to monitor the status of a buzzer for a blaring alarm and to interface and communicate utilizing the microcontroller storage as the main data storage and the Internet. The major concern is the vulnerability of the internet to hackers, which can be easily accessed and send and store data tampered with due to an unencrypted platform. In addition, the author uses the microcontroller memory storage as the device's major data storage. This is a challenge for the device. The microcontroller only consists of 32 megabytes of memory storage capacity, which might not be enough for storing data. Stuffing the built-in memory of the microcontroller and, at the same time, monitoring the status of a buzzer is a complicated task for the device. 
That is why this innovative device of an integrated system for surveillance, monitoring and security utilising the Internet of Things (IoT) has yielded a significant landmark and results. The device combination of sensors, cameras, and automation technologies has enhanced security measures, improved efficiency and increased accuracy in detecting potential threats. The system's real-time monitoring capabilities enable swift response to security breaches, and automated alerts notify authorised personnel of potential threats and store all their encrypted data in the Telegram platform, compared to related works and the traditional contemporary system. 
However, the implementation also highlighted challenges such as ensuring stable internet connectivity, protecting sensitive data from unauthorised access and integrating various sensors and devices. Despite these challenges, the benefits of the IoT-based system are clear. The system's remote monitoring capabilities allow authorised personnel to keep a watchful eye on the compartment from anywhere, and automated responses ensure prompt action in case of security breaches.  According to [14], “Hybrid edge cloud smart surveillance system uses a Raspberry Pi, NoIR (No infrared filter) camera and cloud computing” To provide IoT services while maintaining inference locally at the edge device. The system implements the mobile-first solid state device (SSD) and MobileNetV3 model for object detection, which is deployed using Amazon Web Services (AWS), such as IoT Greengrass and Lambda. The system can scale thousands of surveillance nodes and send notifications to the user through Amazon Simple Notification Service. Different experiments validate the system's performance, achieving positive detections of people and animals in both day and night conditions. Future iterations will focus on zero-touch provisioning, scaling and reducing resource utilization for more resource-constrained devices. Review based on the work; one identified gap is the lack of a comprehensive security surveillance system that includes all necessary characteristics, such as bandwidth.
[15] “A decentralized platform for heterogeneous Internet of Things networks management”. Present design requirements for a heterogeneous and collaborative edge-fog-cloud computing network. Though the varieties of protocol are available for the edge, fog and cloud domains, no standard protocol to follow for a specific IoT system. The primary issues are the choice of the appropriate ALP/s internet of video things system, while leveraging the advances in edge fog and cloud computing. [16] “Internet of Things (IoT): Research, Simulators and Test beds” In their work, the specific issues of communication protocols in the application layer for any video surveillance system (VSS) are yet to be addressed by researchers. To satisfy the protocol requirements, the system designer should consider the devices (which range from the resource-constrained IoT edge nodes to the resourceful clouds), data produced at the IoT edge, fog and cloud layers and the communication architecture of the system. An efficient VSS architecture should be able to achieve all these functionalities. [17] “Low-cost Prototype for IoT-based Smart Monitoring through Telegram” A low cost-effective prototype of the smart monitoring system was developed using a motion-triggered image-capturing technology and a Passive Infrared sensor (PIR). In the work, a developed prototype of hardware and software and the implementation of the camera motion alert using the latest ESP32 Microcontroller.
[bookmark: _Hlk158474947]According to [18] “An Ontology-based Context-aware IoT Framework for Smart Surveillance”, in their work, the continuous live video streaming and data captured by CCTV cameras can be processed on the fly to give real-time alerts to concerned authorities, and these alerts can be disseminated using e-mail, SMS, on-screen alerts and alarms. [19] “Security surveillance and automation system using internet of things” This study implemented the functionality of wireless home automation and home security. The system proposed comprises two parts: a home security system and home automation. The home security system includes the smart security camera module and the Android door lock. The smart security camera module is comprised of a Raspberry Pi and Pi camera. The camera can detect a face of person standing long time in front of the house by implementing the face recognition technique with OpenCV. The person's image will be sent to the homeowner via email. As for the Android door lock, the Raspberry Pi receives a command from the Android device to lock/unlock the door. There are two parts in the home automation system: the rain-sensing windows and the automatic light ON and OFF. The rain-sensing windows used a rain sensor to determine whether it is raining or not. If it rains, the windows of the house will be automatically shut, and the windows will be opened only when the rain stops. Infrared sensors were used to detect the presence of people in the house. If there are people in the house, the light-emitting diode (LED) will trigger ON. And when the people leave the house, the LED will automatically switch OFF. [20] "Home security alarm using Wemos D1 and HC-SR501 sensor-based telegram notification" The authors developed a home security alarm system using WEMOS D1 and HC-SR501 sensor with telegram notification to detect theft in a community. The system helps the community in dealing with theft that enters the house. The sensor is used to detect motion, and the buzzer is connected to sound an alarm and the buzzer is controlled by the WEMOS D1 microcontroller. When an image is detected, a notification is sent to the Telegram App automatically. This system automatically monitors anyone who enters a house in that community. [21] "Wireless Intruder Detection System for Remote Locations" The authors proposed a home with a security system in which the motion sensor triggers the digital camera only when there is an intrusion. After triggering, the camera switched on and started recording instantaneously. This recorded video is transmitted to the station base using a Zigbee or Bluetooth transmission module. At the station base, the information received is decoded to obtain video data.  [22] “Intelligent Video Surveillance (IVS) systems”. In their work, they utilize analytic software to automatically detect objects and security events of interest during video footage. This work had emerged as a response to the limitations of traditional surveillance. However, existing security systems lack important capabilities such as zone barriers, facial recognition, remote surveillance and power outage detection systems.  [23] “Smart surveillance system” It uses an ultrasonic sensor for the detection of any intrusion attempts, the system warns unauthorized persons, and remotely notifies the users. Also included in this system is face recognition for authentication and alerts the owners in case of a power failure, providing a flexible and reliable security solution for various properties. According to [24] “IoT based load automation with remote access surveillance using ESP32-CAM and ESP 8266 Module” (The project focused on, to consolidate IoT in automation with control of garden watering pump and provision of real time surveillance for the allocated areas. The system proposed consists of ESP 8266, ESP32-CAM, Relay Module, Soil Moisture Sensor and Raspberry Pi. The user can control the loads by giving a command in the Blynk Application. The Blynk Server updates the ESP 8266 status to switch the loads. The Moisture Sensor data will notify the Blynk Server to update the current moisture gauge value displayed in the Blynk Application. The user will receive a notification when the moisture content is low. For the surveillance system, live video feeds from ESP32 will be accessed in the live streaming URL from the Blynk Application. According to [25], a ‘based IoT security surveillance system ' they presented, which uses Node Micro-Controller Units (MCUs) and Wi-Fi connectivity. In their work, the system is composed of sensor nodes and a controller section, offering remote user alerts and mobility as key features.  Integrating a Wi-Fi-connected microcontroller with a Passive Infrared (PIR) sensor, the system was able to detect object movements and automatically send notification alerts through an online cloud platform to the user, enhancing its surveillance capabilities.  [26] “IoT-based smart security surveillance system for remote monitoring and control” In their study, they presented an IoT-based security surveillance system using a Raspberry Pi single-board computer with network connectivity. The proposed system consists of a microcontroller, an ultrasonic sensor, GSM module and software. The system uses embedded systems designed to perform a specific task, and Raspberry Pi is a commonly used platform for IoT applications.  [27] “Surveillance camera utilizing IoT and Raspberry Pi microcontroller” Nowadays, individuals and organizations require security. The traditional way of monitoring requires manual observation and a large storage space. To overcome this, the authors came up with the idea of a surveillance camera using Internet of Things incorporated with   Raspberry Pi with a PIR sensor, which requires less storage space as it captures images and records video, only when motion is detected in a specific area. According to [28] “IP-Based Surveillance Robot Using IOT," This paper proposed a smart security robot that checks the presence of an intruder. The robot will move in a specified path at the site through the motor drivers. When the Passive infrared sensor detects human presence, it sends a signal to the Raspberry Pi microcontroller. The Node MCU receives a signal from the Raspberry Pi microcontroller and forwards the signal to the buzzer and global short message module. The global short message module will forward the same message to the user, specifying that a human or object is detected. Live stream footage from the camera can be accessed through the mobile app. [29] “Security Management in Smart Home Environment”. Their paper presented was about a smart home management and security system that protects people from any kind of robbery, sabotage and crime. An installed surveillance camera connected to a Raspberry Pi microcontroller to capture movement and objects in the house. These data are then passed to the Fog Server for verification to determine if the object detected is harmful. If a harmful object is detected, the user receives a notification via the system. The user needs to validate with Cloud Server to log into the web-based interface to view the images been captured. According to [30] “Random Forest learning based indoor localization as an internet of things service for smart buildings”, the authors presented ways to locate people in a smart building using indoor localization internet of things. The problem of the research is to locate people within a building without using any additional infrastructure. Years back, a lot of research proposals had been made to predict the location in a smart building. But the prediction of the accuracy of indoor location positioning is a major challenge. The most essential smart infrastructures for creating smart cities and buildings, they suggested a random-based algorithm machine, as an IoT service for smart buildings. This algorithm machine focuses on the accuracy of indoor positioning. The conducted experiment results shows that 14% improvement in the test prediction success overall data rate. [31] “A Smart Building Surveillance Security System” This paper focuses on a smart building surveillance system, which sends cautions to the concerned individual by utilizing the Internet. In case of any trespass, and raises an alert alternatively. The components utilized in this system were a PIR Sensor, CCTV, Raspberry Pi, Buzzer and Mobile Application. The prototype operation begins with the identification of motion by a Passive Infrared Sensor. If a movement is detected, the CCTV will capture the image of the object. This image is then processed for facial recognition.  The human face or image detected will be stored in cloud storage. And a notification is sent with the image of a human detected by the Mobile App.  [32] “Design of Autonomous Triggering Control System through Motion Detection for Internet of Things-Based Smart Home Surveillance CCTV Camera”. The research objective is to design a simple and single Internet of Things-based closed-circuit television (CCTV) control system that creates a comfortable and safe environment for households, to initiate recording upon triggering a sensor installed at a specific entrance or an exit point in a house.[33] ‘Implementation of Internet of Things and monitoring, safety system in workplace’ In their paper, it is all about rapid facilities development in the workplace continuously and safety calls in workplace premises, and to improve the monitoring system, which only requires a notification alert when there is an intruder or mishap detection [34]. A Smart Building Surveillance Security System. In their paper, the authors focused on the development of a smart building surveillance system, which sends cautions to the concerned individual through the utilization of the Internet. The system raises an alert alternatively when there is a trespass. The components utilized by this system were a PIR Sensor, CCTV, Raspberry Pi, Buzzer and Mobile Application. The prototype operation begins with the detection of motion by the PIR Sensor. The CCTV captures the motion image when motion is detected. This image is then processed for facial recognition. The image or human face detected is stored in cloud storage. And a notification with the image captured or a human face detected is sent to the Mobile App. [35] “Edge Computing-based Handgun and Knife Detection Method in Internet of Things Video Surveillance Systems” In this study, he proposes a single-stage convolutional neural network model that achieves exceptional results and showcases its potential to enhance real-time knife and handgun detection capabilities in IoT-based video surveillance systems. [36] “Smart Surveillance System” They introduced a smart surveillance system that comprises of Raspberry Pi, a PIR Sensor, a Camera Module, a mic and a speaker. When someone is at the doorstep, the passive infrared detects the motion. Raspberry Pi will then trigger the camera ON to capture the image of the intruder. The notification alert of the motion detection is sent to the admin. These images are then compared to the pre-saved images to decide on if the person will be allowed to gain access and use the door. If the images match, the Raspberry Pi board send a signal to the stepper motor, and the stepper motor will open the door, or else the stepper motor remains still. According to [37], “Designing an Autonomous Triggering Control System through Motion Detection for IoT-Based Home Surveillance utilizing closed circuit television Camera”. They introduced a smart security system comprised of an Ultrasonic Sensor, Raspberry Pi, Buzzer, Relay Module and CCTV Camera. When the ultrasonic sensor detects motion, the Raspberry Pi triggers the buzzer connected to the GPIO, the Raspberry Pi and the relay module. When the relay module is triggered, current flows into the CCTV Camera and the camera will switch ON. The Cayenne Application is used to detect the changes in the Raspberry Pi GPIO status. When the status changes, the Cayenne Application send an SMS notification alert to the user. The user can open the Home App to view the live image via the CCTV Camera. The user can switch off the device by first switching off the relay module from the Cayenne Application. [38] “IoT-based security system, utilizing Raspberry Pi”. In their paper presentation, they introduced a security system that views the entire floor for movement. When someone enters the building, a motion is captured by a switch sensor installed under the floor tiles. The Raspberry Pi turns on the camera and captures the motion detected, and sends the detected image to the owner of the building. Finally, the integrated internet of things (IoT) for surveillance, monitoring and security systems has demonstrated its potential to significantly enhance compartment security and efficiency, and its benefits make it an attractive solution for various applications.
3. MATERIALS AND METHODS
Based on the requirements and architecture, the following hardware modules were selected for the design to ensure that all modules were compatible and could work together seamlessly. The ESP-32 CAM sensor, HC-SR501 PIR sensor, MQ-2 gas detector sensor, 3.7V lithium battery and TP4056 charging module. This project combines the above modules listed sensors to create a functional system. The ESP32-CAM module serves as the core processing unit, coordinating sensor data and video streaming. The HC-SR501 PIR sensor adds a layer of motion detection, allowing the system to identify and respond to movement. The MQ-2 gas sensor provides an additional layer of safety by detecting combustible and dangerous gas leakage. Powered by a rechargeable 3.7V lithium battery with a TP4056 charger, ensuring continuous operation. It captures real-time video, detects motion, and monitors air quality for gases like methane, propane, and carbon monoxide. The integration of captured videos, motion detection and gas leakage detection makes it a robust solution for monitoring and responding to potential threat

POWER SUPPLY









ESP 32-CAM
MICROCONTROLLERER









MQ-2GAS LEAKAGE SENSOR









PIR SENSOR









PERSONAL INTERNET HOTSPOT
TELEGRAM STORAGE







               
                     Fig. 2. Functional Block Diagram of the design system.


3.1 POWER SUPPLY SYSTEM.
This system was designed to maintain a stable 3.3V power supply from the 3.7V lithium-ion battery. The TP4056 module ensures the lithium battery is safely charged and protects it from overcharging. The ESP-32 CAM is powered through USB connected with an external power supply source or through a battery, but during construction, a battery was used for continuous operation without power interruption. Board can be energized from 3.3 - 3.7volts. If the system board is energized with a lesser supply of 3.3 volts, the system will be unstable, and if the system uses more than the required voltage of 3.7V, the system will either be burned due to overheating. The recommended voltage range should not exceed 3.3- 3.7 volts  
3.1.1.   Power input supply for ESP32-CAM  
The ESP32-CAM module requires a 3.3V or 5V power supply, this power is provided through the ion lithium battery.
3.1.2.    Power input supply for PIR and MQ2 sensors
 The PIR sensor module and the MQ2 sensor modules require a 3.3V or 5V power supply, which is provided through a separate connection directly to the ESP32-CAM module.
3.1.3.    Voltage Regulation: Voltage regulator regulates a stable 3.3V supply from the 3.7V battery received by ESP32-CAM.
3.1.4.   Battery Management: TP4056 Module manages the battery charging effectively and protects it from overcharging, overheating and ensures efficient energy use.
3.1.5     Battery capacity and Lifespan Calculation:
Power calculation for the ESP32-CAM sensor with a Lithium battery 
To calculate the power requirement for the ESP32-CAM powered by a lithium-ion battery:
Active Mode: The ESP32-CAM consume around 160mA when actively transmitting data or capturing images. 
Calculation:
Assuming the ESP32-CAM consumes around 160mA during operation and 10mA during standby.
Battery capacity = 2000mAh.
Operational time (hours) = Battery capacity / Consumption.	
In active mode: Time= 2000mAh/160 mA= 12.5 hours
By combining the hardware and software elements, the smart surveillance system effectively enhances security by providing real-time monitoring and alerts.
3.2. SYSTEM   DESIGN
The system design comprises the requirement analysis, system Architectural design and programming.
3.2.1. Requirements Analysis
The design started by identifying the key modules required for the design of the surveillance and monitoring security system. After all the individual modules that will make up the design of the system have been confirmed for operational use, the system was set up to function as desired in the design. The primary tasks included video recording, detection, combustible and dangerous gas leakage detection and sending real-time automated alerts.

3.2.2. System Architectural Design 
The device Architecture was designed in units: it started with power management, thereafter, all the different sensors that made up the device, such as the motion detection, video capturing, combustible, dangerous gas leakage detection and communication App. 
The implementation of an integrated system for surveillance, monitoring and security in a compartment using the Internet of Things is broken down into subsystems detailing the interaction between the modules. Each module’s role in the overall system can be described, with emphasis on how it contributes to the system’s objectives. 
The system was designed in two processes: the system architectural design and the system software programming. The architectural design is the assembly of the various modules put together to function as a system, the motion detector sensor, video capture sensor, gas leakage detector sensor and communication App. The software design involves programming of the ESP32-CAM that can handle motion detection, video recording and Telegram-Bot communications. The ESP 32-CAM microcontroller is a Wi-Fi-enabled microcontroller with an integrated camera module. It is known for its versatile applications and low cost. The code was written in Arduino Integrated Development Environment (IDE), which is the primary development environment using libraries of ESP32-CAM, PIR sensor and Telegram-Bot communication. Arduino IDE supports a wide range of libraries and simplifies the processes of writing and code uploading to the microcontroller. The functional block diagram in Figure 2 illustrates the interaction between the components and the data flow within the system, ensuring clarity and coherence.
3.3.    DESIGN  
This design provides a comprehensive solution for surveillance, monitoring and security in a compartment using the Internet of Things. This stage helps in defining the overall system architecture, including both hardware and software components.
The required modules for the device design, as listed, are ESP32-CAM microcontroller including a camera module, PIR for motion detection, MQ-2 for gas detection and a communication module, either WI-FI or GSM (Hotspot). The system architecture is designed to integrate sensors and establish communication with the Telegram platform. The software development involves the downloading of the software from the Arduino Uno website and configuring it by including the variable code for sensor data processing, camera control and communication, as well as setting up the storage (Telegram platform), alerts and developing a web interface for monitoring and control. Features implemented include encryption for secure data, authentication for access control and alerts for suspicious activity or breaches. The device is thereby tested for functionality and security. The design was initially made on a breadboard and later transferred to a case box with room for ventilation to avoid overheating. Below is the step-by-step detail of setting up the device. 
The ESP 32-CAM which is also the microcontroller is mounted on the breadboard as shown in Figure: 3. it was energized with 3.3 volt power supply through the lithium ion battery to ascertain a good working condition as shown in Figure: 4. There-after all the other sensors (PIR sensor and the QM-2 Gas detector sensor were also mounted and connected to the ESP 32-CAM on the breadboard as shown in Figure: 5 Finally moved to a plastic casing box, where the work was certified completed and tested.
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Fig: 3A. ESP 32-CAM on breadboard.              Fig: 3B. ESP 32-CAM Powered                Fig: 3C. ESP 32-CAM connected to PIR Sensor
3.4.	   CIRCUIT DESIGN
The circuit design was done using the Proteus 8 software connecting all components, creating detailed schematic diagrams for each subsystem to the whole system. Distributing of proper voltage regulation system and maintaining of good, stability and reliability. 


[image: ]                                         		Fig.  4. Circuit Diagram (Proteus 8 software)

3.5.   MICROCONTROLLER SIMULATION/PROGRAMMING
The software for the development of the ESP32-CAM to handle various tasks, such as motion detection, video recording, gas leakage detection and Telegram-Bot communication. The following are key functionalities and the corresponding code snippets: The program starts with the Wi-Fi setup connection.
3.6.          SOFTWARE IMPLEMENTATION
In the plan of developing an integrated system for surveillance, monitoring and security, a meticulous journey was embarked on to ensure that every aspect of software was robust and efficient. Here is the detailed account of the software implementation processes.
3.6.1. Development Environment Setup:
Arduino IDE: The microcontroller Arduino IDE latest version was downloaded and installed from the official Arduino website. This environment provided the foundation for all the development efforts.
3.6.2. ESP32 Board Definitions: To work with the ESP32-CAM, I needed to add the board definitions. I navigated to File > Preferences in the Arduino IDE and added the following URL to the "Additional Board Manager URLs" field: https://dl.espressif.com/dl/package_esp32_index.json. Then, I navigated to the Tools > Board > Board Manager, searched for the "esp32" and installed the ESP32 board definitions.
Required Libraries: Ensuring that I had all necessary libraries, I navigated to the Sketch > Include Library > Manage Libraries and installed the following:
ESP32 by Espressif Systems
WiFi by Arduino
Universal Telegram Bot by Brian Lough
3.6.3. Configuring the Arduino IDE for ESP32-CAM
The appropriate board settings for the ESP32-CAM under the Tools > Board were selected:
Board: ESP32 Wrover Module
Partition Scheme: Huge APP (3MB No OTA/1MB SPIFFS)
Additionally, it was ensured that the correct COM port was selected under Tools > Port.
3.6.4. Global Variables and Constants
The Wi-Fi credentials, Telegram bot token, Chat ID, pin definitions and gas detection threshold were defined, including the important libraries. It was crucial at the beginning, but it was ensured that all dependencies were met.
3.7. SYSTEM SETUP 
In the system setup, the serial communication, establishing Wi-Fi connection, the camera and configuring the sensors were initialized.
3.7.1. Code Structure
To maintain clarity and functionality, the code was organized into several sections: initialization, main loop and helper functions. These sections allow each function to be addressed individually and integrated seamlessly.
3.7.2.    Main Loop: The main loop continuously monitors the PIR sensor for motion and the gas sensor for gas levels. Upon detection of motion or a gas leak, the respective functions were triggered to handle these events.
Helper Functions
3.7.3.   Camera Initialization: This function configured and initialized the ESP32-CAM.
3.7.4. Capture and Send Video: This function captures a video and sends it to the Telegram-Bot.
3.7.5. Gas Linkage Detection: This function allows the gas sensor value to be read, and a notification is sent if the threshold is exceeded.
3.7.6. Telegram Bot Communication: This function is to send messages and videos to the Telegram bot.
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          Fig. 5. Schematic diagram of the System flow chart                  



3.8.   MODE OF OPERATION
The system mode of operation functions as a source of surveillance, monitoring and security using the internet. The system uses a motion detection algorithm written in Python as a default programming environment. The algorithm for motion detection is being implemented on a low microcontroller chip (ESP 32-CAM), which enables live video streaming on the detection of moving objects. To achieve this task, a ESP 32-CAM sensor which is also known as the microcontroller or the central processing unit (CPU) was programmed to receive a HIGH input signal from a passive infrared (PIR) module sensor, on receiving this signal, the ESP 32-CAM sensor awakes from a LOW state, capture a motion, compressed it into a live streaming video format and send a real time automated alert to the user through a telegram bot platform. The information is processed and stored in the telegram storage as data. This information is encrypted, and it can only be accessed by the user or authorized personnel.
Likewise, the MQ-2 gas leakage sensor detector, the gas leakage sensor detector monitors the air level for multiple dangerous gases leakage. Gases like methane, propane, butane, carbon monoxide, smoke, and LPG can cause health hazards to the human system. When these gases are released into the air, the MQ-2 sensor detects them in the air and sends a HIGH signal also to the ESP 32-CAM. The ESP 32-CAM processes the information and automatically alerts the user through the same Telegram bot App.
This system was designed to maintain a stable power supply of 3.3 volts from the 3.7 volts from the lithium-ion battery. The recommended voltage range should not exceed 3.3-3.7 Volts.
4. TESTING AND RESULT
The system which consists of software and hardware was designed in Proteus and Professional, the software was embedded in the circuit. The simulation and testing were carried out to ensure that the system performs perfectly without errors at maximum efficiency. The circuit was broken down into units, and all the units were tested cordially. The system performance was thoroughly evaluated. The lithium-ion battery's power supply was assessed, revealing an output of 3.7 Volts, with 3.3 Volts allocated for optimal operation and 0.4 Volts for standby mode. The ESP32-CAM sensor demonstrated its capability to capture images within 25 seconds at a close range of 50-200 cm, with diminishing 
image quality beyond 200 cm. It also exhibited seamless connectivity to the internet via Wi-Fi and hotspot, enabling smooth live streaming and remote monitoring through the Telegram platform. Video streaming tests showed the sensor's ability to stream footage smoothly, with clear image capture and a satisfactory field of view. The HC-SR 501 PIR Image detector sensor proved effective in detecting motion within a 90–120-degree angle and 10-23 feet range, with adjustable sensitivity and a response time of approximately 5 seconds. It demonstrated minimal false triggers and functioned well within a specific temperature range. The MQ-2 Gas Detector Sensor detected the presence of combustible gases, though it couldn't differentiate specific gases. Finally, the device's components performed as expected and satisfactorily.
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Fig. 6A and B. both Images captured at an angle of 45 degrees and a distance of 4 ft.
 





5.   CONCLUSION 
The implementation of an integrated surveillance monitoring and security system using the Internet of Things (IoT) in train compartments offers numerous security benefits. This system provides enhanced security through real-time monitoring, enabling swift response to security breaches. Smart sensors and cameras work together to provide comprehensive security coverage, detecting potential threats and alerting authorities promptly through telegram platform.
The system's automated monitoring capabilities reduce manual efforts, freeing up resources for other tasks. Additionally, IoT-enabled systems can analyze data to identify potential security threats, allowing for proactive measures to be taken.
Remote access to the system enhances flexibility and response times, enabling authorized personnel to monitor and respond to security incidents from anywhere. Customizable alerts and notifications ensure that relevant parties are informed promptly, reducing the risk of security breaches going undetected.
Finally, leveraging IoT technology enables organizations to create a robust, efficient, and effective surveillance monitoring and security system for compartments, providing a safer and more secure environment.
As technology continues to evolve, I strongly suggest that future directions for this system should include integrating artificial intelligence (AI) to enhance threat detection and predictive analytics, incorporating additional sensors for enhanced monitoring, and developing a more user-friendly interface for easier system management.. Expanding this based integration of the internet of things to other devices that can create a more comprehensive security ecosystem should also be encouraged.
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